
Test Date 13/03/2026
Test Time 9:00 AM - 10:30 AM
Subject RRB Technician Grade I Signal
* Note
Correct Answer will carry 1 mark per Question.
Incorrect Answer will carry 1/3 Negative mark per Question.

1. Options shown in green color with a tick icon are correct.
2. Chosen option on the right of the question indicates the option selected by the candidate.

Section : General Awareness

Q.1 ఈ క్రింది వాటిల్లో  భారత రాజ్యాంగం నిషేధించిన పౌరసత్వ రకం ఏది ?

Ans A. భారతదేశ భూభాగంలో పుట్టడం ద్వారా పొందిన పౌరసత్వం

B. నిర్దేశించిన షరతులను నెరవేర్చిన తర్వాత సహజీకరణ ద్వారా పొందిన పౌరసత్వం

C. చట్టబద్ధమైన నిబంధనల ప్రకారం రిజిస్ట్రేషన్ ద్వారా పొందిన పౌరసత్వం

D. భారత పౌరసత్వంతో పాటు మరో దేశ ద్వంద్వ పౌరసత్వం

Q.2 క్రింది వాటిలో, 1991లో భారతదేశంలో పారిశ్రా మిక సంస్కరణలలో ఒక కీలక అంశం కానిది ఏది?

Ans A. కీలక పరిశ్రమలలో ప్రభుత్వ రంగ విస్తరణ

B. గుత్తా ధిపత్యాలు మరియు నిర్బంధ వాణిజ్య పద్ధతుల (MRTP) చట్టం రద్దు

C. విదేశీ ప్రత్యక్ష పెట్టు బడులను (FDI) ప్రో త్సహించడం

D. పరిశ్రమల డీలైసెన్సింగ్

Q.3 89 ఏళ్ల వయసులో కన్నుమూసిన పండిట్ ఛన్నూలాల్ మిశ్రా , ఈ క్రింది ఏ హిందుస్థా నీ శాస్త్రీయ సంగీత ఘరానాతో
సంబంధం కలిగి ఉన్నారు?

Ans A. ఆగ్రా  ఘరానా

B. గ్వాలియర్ ఘరానా

C. జైపూర్-అతరౌలి ఘరానా

D. బనారస్ ఘరానా

Q.4 రాజ్యాంగంలోని ఆర్టికల్ 280(1) ప్రకారం, ఆర్థిక సంఘాన్ని ఈ విధంగా ఏర్పాటు చేయాలి:

Ans A. ప్రతి మూడు సంవత్సరాలకు ఒకసారి

B. ప్రతి ఐదు సంవత్సరాలకు ఒకసారి లేదా అంతకంటే ముందు

C. ప్రతి నాలుగు సంవత్సరాలకు ఒకసారి లేదా అంతకంటే ముందు

D. ప్రతి ఏడు సంవత్సరాలకు ఒకసారి లేదా అంతకంటే ముందు

Q.5 భారత జాతీయ కాంగ్రెస్ మొదటి సమావేశం ఎప్పుడు, ఎక్కడ జరిగింది?

Ans A. డిసెంబర్ 28,1852, పూనా

B. డిసెంబర్ 28,1885, బొంబాయి

C. డిసెంబర్ 28,1885, పూనా

D. జనవరి 12,1885, కలకత్తా
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Q.6 2025లో, దేశం తరపున 50 టెస్ట్ మ్యాచ్‌లు ఆడిన తొలి భారత పేసర్‌గా నిలిచిన భారతీయ క్రికెటర్ ఎవరు?

Ans A. జస్‌ప్రీత్ బూమ్రా

B. భువనేశ్వర్ కుమార్

C. మహ్మద్ షమీ

D. ఇషాంత్ శర్మ

Q.7 ఈ క్రింది జతలలో వాటిలో ఏ జతల శిఖరాలు మరియు వాటి సుమారు ఎత్తు లు తప్పుగా జతపరచబడ్డా యి ?

Ans A. కాంచనజంగా - 8598 m

B. దొడబెట్టా  - 2637 m

C. నంగ పర్బత్ - 7026 m

D. అనైముడి - 2695 m

Q.8 శ్రీ C. P. రాధాకృష్ణన్ భారత _______ ఉపరాష్ట్రపతిగా ప్రమాణ స్వీకారం చేశారు.

Ans A. 12వ

B. 13వ

C. 15వ

D. 14వ

Q.9 ఆధ్యాత్మిక ఇతివృత్తా లతో ముడిపడి ఉన్న పశ్చిమ బెంగాల్‌కు చెందిన ఏ జానపద సంగీత సంప్రదాయాన్ని

వాండరింగ్ మినిస్ట్రెల్ (గాయిని) ప్రదర్శించారు?

Ans A. భవాయి

B. అల్హా

C. బౌల్

D. పాండవాణి

Q.10 బ్రిటిష్ చట్టం మరియు శాంతిభద్రతల జోక్యాన్ని ప్రతిఘటించిన కోల్ తిరుగుబాటు ఏ ప్రాం తంలో జరిగింది?

Ans A. బెంగాల్

B. మైసూరు

C. చోటా నాగపూర్

D. అవధ్

Section : General Intelligence and Reasoning

Q.11 క్రింద ఇవ్వబడిన సంఖ్య మరియు సంకేతాల శ్రేణిని పరిశీలించి, దాని తర్వాత అడిగిన ప్రశ్నకు సమాధానం ఇవ్వండి.
గణనను కేవలం ఎడమ నుండి కుడికి మాత్రమే చేయాలి. శ్రేణిలోని సంఖ్యలన్నీ ఏక-అంకె సంఖ్యలే.

(ఎడమ) 9 1 @ $ 5 1 # 5 9 $ 1 & 4 + 7 = ! 5 & 4 ? (కుడి)

ప్రతిదానికీ తక్షణమే ముందు ఒక సంఖ్య మరియు తక్షణమే తరువాత కూడా ఒక సంఖ్య ఉండేటువంటి సంకేతాలు
ఎన్ని ఉన్నాయి?

Ans A. ఆరు

B. మూడు

C. నాలుగు .

D. ఐదు

Q.12 క్రింద ఇవ్వబడిన రెండు త్రయాలు అనుసరించే నమూనానే అనుసరించే త్రయాన్ని ఎంచుకోండి. రెండు త్రయాలూ ఒకే
నమూనాను అనుసరిస్తా యి.

HN-JF-MO
MS-OK-RT

Ans A. PU-SN-WY

B. PV-RN-UW

C. PV-SN-UY

D. OU-SM-WY
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Q.13 LF 58 అనేది ఒక నిర్దిష్ట  మార్గంలో ID 49 కి సంబంధించినది. అదే విధంగా, YK 36 అనేది VI 27కి సంబంధించినది.
అదే తర్కాన్ని అనుసరించి, RO 61 ఈ క్రింది వాటిలో దేనికి సంబంధించినది?

Ans A. OH 59

B. OG 55

C. OM 52

D. OV 53

Q.14 ఏడుగురు వ్యక్తు లు, C, D, E, F, W, X మరియు Y లు కేంద్రా భిముఖంగా ఒక వృత్తా కార బల్ల  చుట్టూ  కూర్చున్నారు. D
కి ఎడమవైపు నుండి లెక్కించినప్పుడు C మరియు D మధ్య ఇద్దరు వ్యక్తు లు మాత్రమే కూర్చుంటారు. X అనే వ్యక్తి D
కి తక్షణ కుడి వైపున కూర్చుంటాడు. D మరియు E మధ్య ముగ్గు రు వ్యక్తు లు మాత్రమే కూర్చుంటారు. F అనే వ్యక్తి W
కి తక్షణ కుడి వైపున కూర్చుంటాడు. F కి కుడి వైపున నుండి లెక్కించినప్పుడు Y మరియు F మధ్య ఎంత మంది
కూర్చుంటారు?

Ans A. ముగ్గు రు

B. సున్నా

C. ఇద్దరు

D. ఒకరు

Q.15 విజయ్ A స్థా నం నుండి ప్రా రంభించి ఉత్తరం వైపు 10 km డ్రైవ్ చేస్తా డు. తరువాత అతను ఎడమవైపు తిరిగి 4 km
డ్రైవ్ చేసి మళ్ళీ ఎడమవైపు తిరిగి 12 km డ్రైవ్ చేస్తా డు. తరువాత అతను ఎడమవైపు తిరిగి 9 km డ్రైవ్
చేస్తా డు. అతను చివరగా ఎడమవైపు తిరిగి 2 km డ్రైవ్ చేసి P స్థా నం వద్ద  ఆగుతాడు. A స్థా నానికి మళ్ళీ
చేరుకోవడానికి అతను ఎంత దూరం మరియు ఏ దిశ వైపు డ్రైవ్ చేయాలి (అతి తక్కువ దూరం)? (పేర్కొనకపోతే
తప్ప అన్ని మలుపులు 90 డిగ్రీల మలుపులు మాత్రమే)

Ans A. తూర్పు వైపు 4 km

B. పశ్చిమం వైపు 5 km

C. పశ్చిమం వైపు 4 km

D. తూర్పు వైపు 5 km

Q.16 ఇచ్చిన అక్షరం, సంఖ్య మరియు సంకేత శ్రేణిని చూడండి మరియు తదుపరి ప్రశ్నకు సమాధానం ఇవ్వండి. ఎడమ
నుండి కుడికి మాత్రమే లెక్కించాలి

(ఎడమ) F 5 @ £ T 7 Y € V D © 3 € 6 % X 1 Z £ € G * (కుడి)

శ్రేణి నుండి అన్ని సంఖ్యలను తొలగించినట్లయితే, ఈ క్రింది వాటిలో ఏది ఎడమ నుండి ఆరవది?

Ans A. T

B. £

C. Y

D. €

Q.17 ఈ క్రింది సమీకరణంలో,'+'మరియు'-'పరస్పరం మార్చి ,'x'మరియు'÷' పరస్పరం మార్చినట్లైతే, '? 'స్థా నంలో ఏమి
వస్తుం ది?

297 x 11 - 17 ÷ 18 + 91 =?

Ans A. 245

B. 240

C. 248

D. 242

Q.18 క్రింది సంఖ్య మరియు సంకేత శ్రేణిని పరిశీలించి, తరువాత వచ్చే ప్రశ్నకు సమాధానం ఇవ్వండి. లెక్కింపు ఎడమ
నుండి కుడికి మాత్రమే చేయాలి.

(ఎడమ) 1 3 € £ 7 4 6 ¥ 2 8 $ 6 3 1 ◇ 1 3 9 ○ 2 5 ☆7 5 9 (కుడి)

ప్రతిదానికీ తక్షణమే ముందు ఒక బేసి సంఖ్య మరియు తక్షణమే తరువాత సరి సంఖ్య ఉండేటువంటి సంకేతాలు
ఎన్ని ఉన్నాయి?

Ans A. మూడు

B. రెండు

C. నాలుగు

D. ఒకటి
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Q.19 ఒక నిర్దిష్ట  తర్కాన్ని అనుసరించి 10 అనేది 22కి సంబంధించినది. అదే తర్కాన్ని అనుసరించి, 24 అనేది 50కి
సంబంధించినది. అదే తర్కాన్ని అనుసరించి, 6 అనేది ఇచ్చిన ఐచ్చికాలలో దేనికి సంబంధించినది?

(గమనిక: సంఖ్యలను విడివిడి అంకెలుగా విడగొట్టకుండా, మొత్తం సంఖ్యలపై పరిక్రియలు చేయాలి. ఉదా. 13 కి
కలపడం/13 నుంచి తీసివేయడం/13 తో గుణించడం వంటి పరిక్రియలను 13 పై చేయవచ్చు కానీ 13ని 1 మరియు

3గా విడగొట్టి , ఆపై 1 మరియు 3లపై గణిత పరిక్రియలు చేయడం అనుమతించబడదు)

Ans A. 12

B. 14

C. 16

D. 18

Q.20 ఈ క్రింది ఇవ్వబడిన రెండు త్రికాలు అనుసరించే నమూనాను అనుసరించే త్రికాన్ని ఎంచుకోండి. రెండు త్రికాలు ఒకే
నమూనాను అనుసరిస్తా యి.

MAKE – MEKA – AEMK
LOAD – LDAO - ODLA

Ans A. VIEW – WVIE – EWIV

B. RENT – RTEN – ENRT

C. WIND – WDNI – IDWN

D. GROW – ROWG – ORGW

Q.21 19 అనేది ఒక నిర్దిష్ట  తర్కాన్ని అనుసరిస్తూ  64కి సంబంధించినది. అదే తర్కాన్ని అనుసరించి, 28 అనేది 91కి
సంబంధించినది. అదే తార్కాన్ని అనుసరించి ఈ క్రింది వాటిలో 44కి సంబంధించినది ఏది?

(గమనిక: సంఖ్యలను వాటి విడి అంకెలుగా విభజించకుండా, మొత్తం సంఖ్యలపైనే గణిత పరిక్రియలను చేయాలి.
ఉదాహరణకు, 13 – 13పై కూడిక, తీసివేత, గుణకారం మొదలైన గణిత పరిక్రియలను చేయవచ్చు. 13ను 1 మరియు

3గా విభజించి, ఆ తర్వాత 1 మరియు 3పై గణిత పరిక్రియలను చేయడం అనుమతించబడదు.)

Ans A. 131

B. 139

C. 193

D. 113

Q.22 ఒక నిర్దిష్ట  కోడ్ భాషలో,

A + B అంటే 'A అనే వ్యక్తి B కి కుమారుడు',
A – B అంటే 'A అనే వ్యక్తి B కి సోదరుడు',
A x B అంటే 'A అనే వ్యక్తి B కి భార్య', మరియు

A ÷ B అంటే 'A అనే వ్యక్తి B కి తండ్రి'.

పైన పేర్కొన్న దాని ఆధారంగా, 'L + M ÷ N x O – P' అయితే L అనే వ్యక్తి P కి ఏమవుతారు?

Ans A. భార్యకి తండ్రి.

B. భార్యకి సోదరుడు.

C. సోదరుడి భార్యకి తండ్రి

D. సోదరుడి భార్యకి సోదరుడు

Q.23 ఒక ప్రశ్న తరువాత I మరియు II అనే రెండు ప్రకటనలు ఉంటాయి. ప్రకటనలలో అందించిన డేటా ప్రశ్నకు
సమాధానం ఇవ్వడానికి సరిపోతుందా లేదా అనేది మీరు నిర్ణయించాలి. రెండు ప్రకటనలని చదివి, సరైన
సమాధానాన్ని ఎంచుకోండి.

A, B, C, D, E మరియు F అనే ఆరుగురు వ్యక్తు లు ఉత్తరాభిముఖంగా ఒక సరళ రేఖలో కూర్చున్నారు. E కి తక్షణ
ఎడమ వైపున ఎవరు కూర్చున్నారు?
I. B అనే వ్యక్తి Cకి కుడి వైపున నాల్గవ స్థా నంలో కూర్చున్నాడు. C మరియు F మధ్య ఒక వ్యక్తి మాత్రమే

కూర్చున్నాడు. F కి కుడి వైపున మూడవ స్థా నంలో D కూర్చున్నాడు.
II. C వరుసకి అత్యంత ఎడమ చివరన ఉంటాడు. C మరియు E మధ్య ఇద్దరు వ్యక్తు లు మాత్రమే కూర్చుంటారు. D కి
ఎడమ వైపున నాల్గవ స్థా నంలో A కూర్చుంటాడు.

Ans A. ప్రకటన I లోని డేటా మాత్రమే ప్రశ్నకు సమాధానం ఇవ్వడానికి సరిపోతుంది, అయితే ప్రకటన II లోని డేటా సరిపోదు.

B. ప్రకటన II లోని డేటా మాత్రమే ప్రశ్నకు సమాధానం ఇవ్వడానికి సరిపోతుంది, అయితే ప్రకటన I లోని డేటా సరిపోదు.

C. ప్రశ్నకు సమాధానం ఇవ్వడానికి I మరియు II రెండు ప్రకటనలలోని డేటా కలిపితే సరిపోదు.

D. ప్రశ్నకు సమాధానం ఇవ్వడానికి I మరియు II రెండు ప్రకటనలలోని డేటా మొత్తంగా కలిపితే సరిపోతుంది (విడివిడిగా కాదు)
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Q.24 M, N, O, P, Q, R మరియు S లలో ప్రతి ఒక్కరూ సోమవారం నుండి ప్రా రంభమై అదే వారం ఆదివారం ముగిసే
వారంలో వేర్వేరు రోజులలో ఒక ఆట ఆడతారు. M బుధవారం ఆట ఆడతాడు. M మరియు Q మధ్య ఆటను ఇద్దరు
వ్యక్తు లు మాత్రమే ఆడతారు. R కి తక్షణ ముందు రోజు O ఆట ఆడతాడు కానీ గురువారం కాదు. N మరియు S
మధ్య ఆటను ఇద్దరు వ్యక్తు లు మాత్రమే ఆడతారు. చివరి రోజున N ఆట ఆడడు. ఏ రోజున P ఆట ఆడతారు?

Ans A. గురువారం

B. శుక్రవారం

C. సోమవారం

D. మంగళవారం

Q.25 ఆంగ్ల అక్షర క్రమం ఆధారంగా, క్రింద ఇచ్చిన నాలుగు అక్షర-సమూహాలలో మూడు ఒక ప్రత్యేక రీతిలో ఒకే విధంగా
ఉంటూ, తద్వారా ఒక సముదాయంగా ఏర్పడుతాయి. ఆ సముదాయానికి చెందని అక్షర-సమూహం ఏది?
(గమనిక: భిన్నమైన పదం హల్లు లు /అచ్చుల సంఖ్య లేదా అక్షర-సమూహంలో వాటి స్థా నంపై ఆధారపడి ఉండదు.)

Ans A. TOQ

B. RMO

C. KEH

D. MHJ

Section : Basics of Computers and Application

Q.26 MS ఎక్సెల్‌లో, B మరియు C నిలువు వరుసల మధ్య కొత్త  నిలువు వరుసను ఇన్సర్ట్ చేయడానికి ఏ ఆప్షన్ ను
ఎంచుకోవాలి?

Ans A. కాలమ్ B హెడర్ పైన రైట్ క్లిక్ చేయండి → డిలీట్

B. కాలమ్ C సెలెక్ట్ చేయండి -----> డిలీట్ ప్రెస్ చేయండి

C. కాలమ్ C హెడర్ పైన రైట్ క్లిక్ చేయండి ----> ఇన్సర్ట్

D. "క్లియర్ కంటెంట్స్" ను ఉపయోగించండి

Q.27 మైక్రోసాఫ్ట్ ఎక్సెల్ 2021లో, R1C1 రిఫరెన్స్ స్టైల్ ప్రకారం 8వ అడ్డు  వరుస ( రో 8) మరియు 'E' నిలువు వరుస
(కాలమ్ E) లో ఉన్న సెల్‌ను ఏ విధంగా సూచిస్తా రు ?

Ans A. 8R5C

B. RC85

C. R8C5

D. 8RC5

Q.28 ఈమెయిల్ లో రిప్లై (Reply) మరియు ఫార్వర్డ్ (Forward) ల మధ్య తేడా ఏమిటి?

Ans A. రిప్లై అసలు సందేశాన్ని తొలగిస్తుం ది, ఫార్వర్డ్ దానిని సేవ్ చేస్తుం ది.

B. రిప్లై ఈమెయిల్‌ను కాంటాక్ట్‌లందరికీ పంపుతుంది, ఫార్వర్డ్ ఎవరికీ పంపదు.

C. రిప్లై ఈమెయిల్‌ను ఎన్‌క్రిప్ట్ చేస్తుం ది, ఫార్వర్డ్ చేయదు.

D. రిప్లై అనేది మీ ప్రతిస్పందనను అసలు పంపిన వ్యక్తికి మాత్రమే పంపుతుంది, కానీ ఫార్వర్డ్ అనేది ఆ ఈమెయిల్‌ను కొత్త గ్రహీతకు పంపుతుంది.

Q.29 ఎక్సెల్ లేదా ఆఫీస్ అప్లికేషన్లలో షేప్స్, యారోస్ మరియు ఫ్లో చార్ట్ ఎలిమెంట్స్ ను గీయడానికి మీకు ఉపయోగపడే

టూల్‌బార్ ఏది?

Ans A. ఫార్ములా టూల్‌బార్

B. స్టాం డర్డ్ టూల్‌బార్

C. డ్రా యింగ్ టూల్‌బార్

D. ఫార్మాటింగ్ టూల్‌బార్

Q.30 అనేక ఇ-మెయిల్ క్లయింట్‌లలో ఒక యూజర్ ఒక ఫైల్‌ని ఇ-మెయిల్‌కి ఎలా అటాచ్ చేయవచ్చు?

Ans A. 'Send' బటన్ నొక్కి, ఒక ఫైల్‌ని సెలెక్ట్ చేసుకోవడం.

B. Ctrl + A ని ప్రెస్ చేసి ఒక ఫైల్‌ని అటాచ్ చేయడం.

C. ఎడిట్ మెనూకి వెళ్లి 'Add File' ని సెలెక్ట్ చేసుకోవడం.

D. 'Attach File' లేదా పేపర్‌క్లిప్ ఐకాన్‌ను క్లిక్ చేసి, ఒక ఫైల్‌ని సెలెక్ట్ చేసుకోవడం.
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Q.31 క్లయింట్ నుండి సున్నితమైన సమాచారాన్ని కలిగి ఉన్న ఇమెయిల్ వస్తుం ది. తదుపరి చర్య కోసం దానిని
సహోద్యోగికి పంపాల్సి ఉంటుంది. ఈ ప్రక్రియలో సున్నితమైన సమాచారాన్ని భద్రపరచడానికి ఏ చర్యలు తీసుకోవాలి
?

Ans A. మీ సహోద్యోగికి కాల్ చేసి సున్నితమైన సమాచారాన్ని మౌఖికంగా పంచుకోవడం

B. ఇమెయిల్ ను అలాగే ఫార్వార్డ్ చేయడం

C. ఫార్వార్డ్ చేసే ముందు సున్నితమైన సమాచారాన్ని తొలగించడం(రీడాక్ట్)

D. సున్నితమైన సమాచారం ఉన్న మెయిల్ డిలీట్ చేయడం

Q.32 ఈ క్రింది వాటిలో MS Word లోని 'పవర్ సేవింగ్ మోడ్' కు సంబంధించి ఏది సత్యం?

Ans A. MS Word లో CPU వినియోగాన్ని తగ్గించడానికి మరియు ఎడిటింగ్ ఫీచర్లను నిలిపివేయడానికి ప్రత్యేకమైన 'పవర్ సేవింగ్ మోడ్' ఉంది.

B. Word లోని పవర్ సేవింగ్ మోడ్ శక్తిని ఆదా చేయడానికి అన్ని డాక్యుమెంట్లను ఆటోమేటిక్‌గా ప్లెయిన్ టెక్స్ట్‌గా మారుస్తుం ది.

C. పవర్ సేవింగ్ మోడ్‌ను ఎనేబుల్ చేయడం వల్ల ప్రింటింగ్ మరియు స్పెల్-చెకింగ్ శాశ్వతంగా నిలిపివేయబడతాయి.

D. కంప్యూటర్ యొక్క పవర్-సేవింగ్ మోడ్ ఎనేబుల్ అయినప్పుడు, MS Word ఆటోమేటిక్‌గా తన పనితీరును సర్దు బాటు చేసుకుంటుంది మరియు

బ్యాక్‌గ్రౌండ్ ఆపరేషన్లను తగ్గిస్తుం ది

Q.33 ఆప్టిమల్ డాక్యుమెంట్ ప్రింటింగ్ రిజల్ట్‌ల కోసం ఏ అంశాలను పరిగణనలోకి తీసుకోవాలి?

Ans A. ప్రింటింగ్ సెట్టింగులు తుది రిజల్ట్‌పై ఎలాంటి ప్రభావం చూపవు.

B. ప్రింటర్ సెలెక్షన్, పేపర్ టైప్, ప్రింట్ క్వాలిటీ, కలర్ ఆప్షన్స్ మరియు పేజీ రేంజ్ సెట్టింగులు ప్రింటింగ్ ఫలితాలను మరియు రిసోర్స్ ఎఫిషియన్సీ‌ని ప్రభావితం
చేస్తా యి.

C. డిఫాల్ట్ ప్రింటింగ్ సెట్టింగులు ఎల్లప్పుడూ తగినవిగా ఉంటాయి.

D. సెట్టింగులతో సంబంధం లేకుండా డాక్యుమెంట్‌లన్నీ ఒకే విధంగా ప్రింట్ చేస్తా యి

Q.34 మౌజ్ ని డ్రా గ్ చేయకుండా MS వర్డ్ 365లో మొత్తం వాక్యాన్ని ఎంచుకోవడానికి షార్ట్ కట్ ఏది?

Ans A. Ctrl + Shift + →

B. Ctrl + Click

C. వాక్యంలో ఎక్కడైనా Ctrl + Click

D. Ctrl + Shift + End

Q.35 మీ ప్రజంటేషన్ యొక్క డిజైన్ టెంప్లేట్‌ను మార్చుకోవడానికి అవసరమైన ఆప్షన్లు  ఎక్కడ ఉంటాయి ?

Ans A. ఇన్సర్ట్ ట్యాబ్

B. హోమ్ ట్యాబ్

C. వ్యూ ట్యాబ్

D. డిజైన్ ట్యాబ్

Q.36 విండోస్ ప్రస్తు తం ఓపెన్ చేయబడిన ప్రో గ్రా మ్‌లను ప్రదర్శించే ______కలిగివుంటుంది. ఇది ఏదైనా నిర్దిష్ట  ప్రో గ్రా మ్‌లను
యాక్సెస్ చేయడానికి కూడా యూజర్‌లను అనుమతిస్తుం ది.

Ans A. స్టా ర్ట్ మెనూ

B. టాస్క్ మేనేజర్

C. ఫైల్ ఎక్స్‌ప్లో రర్

D. టాస్క్‌బార్

Q.37 ఒక స్విచ్డ్  ఈథర్నెట్ లాన్ లో, గమ్యస్థా న MAC అడ్రస్ చదివిన వెంటనే ఫ్రేమ్‌ను ఫార్వార్డ్ చేయడం ప్రా రంభించే పద్ధతి
ఏది? ఈ పద్ధతి అత్యల్ప ఆలస్య సమయాన్ని కలిగి ఉంటుంది, కానీ పాడైపోయిన ఫ్రేమ్‌లను కూడా పంపే ప్రమాదం

ఎక్కువగా ఉంటుంది

Ans A. స్టో ర్-అండ్-ఫార్వర్డ్ స్విచింగ్

B. టోకెన్ పాసింగ్

C. కట్-త్రూ  స్విచింగ్

D. ఫ్రా గ్మెంట్-ఫ్రీ స్విచింగ్

Q.38 ఒక కంప్యూటర్ సిస్టమ్‌లో PCB పాత్రను క్రింది వాటిలో ఏది ఉత్తమంగా వివరిస్తుం ది?

Ans A. డేటాను ట్రా న్స్‌ఫర్ చేయడానికి ఒక ఇన్‌పుట్ పరికరం

B. వైర్‌లెస్ నెట్‌వర్క్‌లో ఉపయోగించే ఒక ప్రో టోకాల్

C. ఎలక్ట్రా నిక్ కాంపొనెంట్‌లను కనెక్ట్ చేసే ఒక ఫిజికల్ బోర్డు

D. వైరస్ తొలగింపు కోసం ఒక సాఫ్ట్‌వేర్ టూల్

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.39 విండోస్ ఆపరేటింగ్ సిస్టమ్‌లో ఓపెన్ ప్రో గ్రా మ్‌ల మధ్య నావిగేట్ అవ్వడానికి ఉపయోగించే షార్ట్‌కట్ కీ ఏది?

Ans A. Alt + Del

B. Alt + Ins

C. Alt + F4

D. Alt + Tab

Q.40 MS PowerPointలో, MS Word లేదా MS Excel నుండి టేబుల్‌లను ఇన్‌సర్ట్ చేయడానికి ఏ ఫీచర్ వీలు
కల్పిస్తుం ది?

Ans A. ఫైల్ > ఇంపోర్ట్ (File > Import )

B. హోమ్ > టేబుల్ (Home > Table)

C. ఇన్‌సర్ట్ > టేబుల్ (Insert > Table)

D. ఇన్‌సర్ట్ > ఆబ్జెక్ట్ (Insert > Object )

Q.41 క్రింది వాటిలో, సాధారణంగా ఉపయోగించే ఇంటర్నెట్ సేవలు మరియు వాటి ప్రా థమిక విధుల సరైన కలయిక ఏది?

Ans A. FTP-బ్రౌ జింగ్ వెబ్‌సైట్‌లు; Email -లైవ్ చాటింగ్; VoIP-ఫైల్‌లను ప్రింట్ చేయడం

B. FTP – ఫైల్‌లను ట్రా న్స్‌ఫర్ చేయడం; VoIP – వాయిస్ కమ్యూనికేషన్; Email – మెసేజ్‌లను సెండ్ చేయడం మరియు రిసీవ్ చేసుకోవడం

C. WWW-ఫైల్ ట్రా న్స్‌ఫర్; Email -రియల్ టైమ్ వీడియో కాలింగ్; Telnet -ఫోటోలను పంపడం

D. Email -రిమోట్ యాక్సెస్; WWW- ఫైల్ ఎన్‌క్రిప్షన్; FTP- హార్డ్‌వేర్ డ్రైవర్‌లను మ్యానేజ్ చేయడం

Q.42 కంప్యూటర్ సిస్టమ్‌ను బూట్ అప్ చేయడానికి సిస్టమ్ సాఫ్ట్‌వేర్ కాంపొనెంట్ ________ బాధ్యత వహిస్తుం ది.

Ans A. CGI/ETF

B. CLI/GUI

C. HDMI/VGA

D. BIOS/UEFI

Q.43 మీ వద్ద  వర్డ్ లోకి పేస్ట్ చేయబడిన పెద్ద , కామా-సపరేటెడ్ చేయబడిన డేటా సెట్ ఉంది, ఇక్కడ ప్రతి లైన్ కొత్త
అడ్డు వరసను సూచిస్తుం ది మరియు కామాలు (,) ఇండివిజువల్ సెల్స్ ని ఆక్యుపై చేయాల్సిన డేటాను వేరు చేస్తా యి.
డేటా సరిగ్గా  పార్స్ చేయబడిందని నిర్ధా రించుకుంటూ ఈ టెక్స్ట్ టేబులుగా ఖచ్చితంగా మార్చడానికి, మైక్రోసాఫ్ట్
365లో MS వర్డ్ ఉపయోగిస్తు న్నప్పుడు మీరు ఏ క్రమాన్ని తీసుకోవాలి?

Ans A. మొత్తం టెక్స్ట్ ను ఎంచుకోండి, ఇన్సర్ట్ ట్యాబ్ వెళ్లి, టేబుల్ క్లిక్ చేసి, కన్వర్ట్ టెక్స్ట్ టు టేబుల్ ఎంచుకోండి మరియు సెపరేటర్ కారెక్టర్ కామాలకు సెట్
చేయబడిందని నిర్ధా రించండి.

B. మొత్తం టెక్స్ట్ ను ఎంచుకోండి, ఇన్సర్ట్ ట్యాబ్ వెళ్లి, టేబుల్ క్లిక్ చేసి, క్విక్ టేబుల్స్ ఎంచుకోని, ఆపై తగిన శైలిని ఎంచుకోండి.

C. మొత్తం టెక్స్ట్ ను ఎంచుకోండి, లేఅవుట్ ట్యాబ్ వెళ్లండి (టేబుల్ టూల్స్ కింద), టెక్స్ట్ డైరెక్షన్ ఎంచుకోండి మరియు కన్వర్ట్ టెక్స్ట్ టు టేబుల్ ఎంపికను
ఎంచుకోండి

D. మొత్తం టెక్స్ట్ ను ఎంచుకోండి, టేబుల్ ప్రా పర్టీస్ డయలాగ్ బాక్స్ ఓపెన్ చేయండి, రో ట్యాబ్ నావిగేట్ చేయండి మరియు స్థిరమైన రో హైట్ ని పేర్కొనండి,
ఇది స్వయంచాలకంగా మార్పిడిని ప్రేరేపిస్తుం ది.

Q.44 MS వర్డ్ 2021 లోని టేబులులో కాలమ్స్ మరియు రోలని ఇన్సర్ట్ మరియు డిలీట్ చేయడం గురించి ఈ క్రింది
ప్రకటనలను పరిగణించండి:
ట్యాబ్ కీని ఉపయోగించి టేబుల్ చివరిలో మాత్రమే కొత్త  రో లను ఇన్సర్ట్ చేయవచ్చు.
టేబుల్ టూల్స్ క్రింద ఉన్న లేఅవుట్ ట్యాబ్ వినియోగదారులను టేబుల్ లోపల ఏ స్థా నంలోనైనా కాలమ్స్ మరియు

రో లని ఇన్సర్ట్ లేదా డిలీట్ చేయడానికి అనుమతిస్తుం ది.
రైట్-క్లిక్ కాంటెక్స్ట్ మెనూ కాలమ్స్ మరియు రో లని ఇన్సర్ట్ మరియు డిలీట్ చేయడానికి శీఘ్ర ఎంపికలను
అందిస్తుం ది.
పైన పేర్కొన్న ప్రకటనలలో ఏది/వి సరైనది/వి?

Ans A. ప్రకటన 1, ప్రకటన 2, మరియు ప్రకటన 3

B. ప్రకటన 1 మరియు ప్రకటన 2 మాత్రమే

C. ప్రకటన 2 మరియు ప్రకటన 3 మాత్రమే

D. ప్రకటన 1 మరియు ప్రకటన 3 మాత్రమే

Q.45 క్లిప్ ఆర్ట్ లో ఉండునవి:

Ans A. సౌండ్ ఫైళ్లు

B. యానిమేటెడ్ GIFలు & డ్రా యింగ్లు

C. చార్టు లు మాత్రమే

D. వీడియోలు మాత్రమే

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Section : Mathematics

Q.46 X ∪ Y అనునది 56 మూలకాలను, X అనునది 45 మూలకాలను మరియు Y అనునది 33 మూలకాలను
కలిగివుండేలా, X మరియు Y అనే రెండు సమితులలో, X ∩ Y ఎన్ని మూలకాలు కలిగివుంటుంది?

Ans A. 19

B. 13

C. 22

D. 25

Q.47
ఒక అర్ధగోళ గిన్నెలో  నీరు ఉంటుంది. ఒకవేళ 2 cm వ్యాసార్థం ఉన్న బంతిని గిన్నెలోకి వేస్తే, గిన్నె

నుండి అదనపు నీరు బయటకు పోకుండా నీటి మట్టం గిన్నె ఎత్తు  వరకు పెరుగుతుంది. అయిన గిన్నె యొక్క

వ్యాసార్థం ఎంత?

Ans A. 6 cm

B. 4 cm

C. 2 cm

D. 8 cm

Q.48 The following table represents the marks obtained by six students in an aptitude test.
Study the data carefully and answer the questions given below by matching the following
types.
Student A B C D E F
Marks 48 50 52 55 60 65

Match the following (standard deviation values are rounded off to two decimal places):
A. Standard deviation of entire dataset I. 5.88
B. Standard deviation of only the middle four values (B, C, D, E) II. 3.77
C. Standard deviation of only first three values (A, B, C) III. 4.08
D. Standard deviation of only last three values (D, E, F) IV. 1.63

Ans A. A − II, B − IV, C − III, D −I

B. A − II, B − IV, C − I, D − III

C. A − I, B − II, C − III, D − IV

D. A − I, B − II, C − IV, D − III

Q.49 A (2,3) మరియు B (-4,5) బిందువుల నుండి సమాన దూరంలో x-అక్షం మీద గల P బిందువు యొక్క నిరూపకాలను
కనుగొనండి.

Ans A. 

B. 

C. 

D. 

Q.50 A(-16, 13), B(-2, -9) మరియు C(2, 13) లు శీర్షా లుగా కలిగిన త్రిభుజం ABC యొక్క సెంట్రా యిడ్(కేంద్రా భాసం)
యొక్క నిరూపకాలు ఏమిటి?

Ans
A. 

B. 

C. 

D. 
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Q.51 సూక్ష్మీకరించండి : (2.5 × 0.48 ÷ 0.6) + (3.5 + 1.6 ÷ 0.8) − (4.8 × 0.25 ÷ 0.8)

Ans A. 7

B. 8

C. 6

D. 5

Q.52 a = 18 మరియు d = 30 అయితే, అప్పుడు A.P(అంక శ్రేఢి) యొక్క మొదటి 6 పదాల మొత్తం?

Ans A. 555

B. 561

C. 559

D. 558

Q.53 మూడు అంకెలు కలిగిన రెండు సంఖ్యల గ.సా.భా 19 మరియు వాటి క.సా.గు 760. అటువంటి జతల సంఖ్య :

Ans A. 2

B. 3

C. 0

D. 1

Q.54 ఒక పరీక్షలో, క్రిస్ రెండు ప్రశ్నలకు సమాధానం ఇవ్వాలి.
మొదటి ప్రశ్నకి సరైన సమాధానం చెప్పే సంభావ్యత 1/5. అతను మొదటి ప్రశ్నకి సరిగా సమాధానం చెప్తే, రెండవ
ప్రశ్నకి సరైన సమాధానం చెప్పే సంభావ్యత 5/6.
క్రిస్ మొదటి ప్రశ్నకి సరైన సమాధానం చెప్పకపోతే, రెండవ ప్రశ్నకి సరైన సమాధానం చెప్పే సంభావ్యత 1/4. క్రిస్
రెండవ ప్రశ్నకి తప్పు సమాధానం చెప్పే సంభావ్యత కనుగొనండి.
[గమనిక: సరైన లేదా తప్పుగా, ప్రతి ప్రశ్నకు సమాధానం ఇవ్వబడుతుంది]

Ans
A. 

B. 

C. 

D. 

Q.55 1120.17 = x, 1120.94 = y మరియు xz = y6 ఇచ్చినట్లయితే, అప్పుడు z విలువ దీనికి సమీపంగా ఉంటుంది:

Ans A. 33.18

B. 34.19

C. 34.73

D. 32.2

Q.56 ఒక స్థూ పాకార స్తంభం 28 cm వ్యాసం మరియు 25 m ఎత్తు లను కలిగి ఉంది. స్తంభం యొక్క వక్రతలాన్ని చదరపు
మీటరుకు ₹50 ల చొప్పున రంగు వేయడానికి అయ్యే ఖర్చును కనుగొనండి.

( ని ఉపయోగించండి)

Ans A. ₹1100

B. ₹1072

C. ₹1138

D. ₹1080

Q.57
 ను సూక్ష్మీకరించండి.

Ans A. 2

B. 0

C. 1

D. - 1
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Q.58 S = {1,2,3,4,5,6,7,8} సమితి యొక్క పవర్ సెట్(ఘాతాంక సమితి)P(S) లోని మూలకాల సంఖ్య:

Ans A. 250

B. 256

C. 247

D. 258

Q.59 ఒక AP(అంక శ్రేఢి) యొక్క 8వ మరియు 12వ పదాల మొత్తం 100 అయితే, మరియు 20వ పదం 95 అయితే,
అప్పుడు 7వ పదం ఏమిటి?

Ans A. 38.5

B. 39.5

C. 36.5

D. 37.5

Q.60
ఒకవేళ E మరియు F అనేవి P(E) =  మరియు P(F) =  అయ్యే రెండు పరస్పర విరుద్ధ  ఘటనలు అయినచో,

Pని కనుగొనండి (E కాదు మరియు F కాదు).

Ans
A. 

B. 

C. 

D. 

Q.61 ఒక గాలిపటం ఆకాశంలో ఎగురుతూ ఉంది. ఒక వ్యక్తి 40 m పొడవైన గట్టిగా సాగతీసిన దారంతో గాలిపటాన్ని
పట్టు కున్నాడు. దారం యొక్క క్షితిజ సమాంతర కోణం 30 డిగ్రీలు అయితే గాలిపటం యొక్క ఎత్తు ను (మీటర్లలో)
కనుగొనండి.

Ans A. 10

B. 20

C. 15

D. 30

Q.62 ఒక త్రిభుజం యొక్క కోణాలు వరుసగా  అయినచో,  విలువను కనుగొనండి.

Ans A. 24

B. 48

C. 40

D. 32

Q.63  త్రిభుజం అనేది త్రిభుజానికి సారూప్యమైనది. AM మరియు PS అనేవి ఉన్నతులు(ఆల్టిట్యూడ్స్)

మరియు AN మరియు PT అనేవి మధ్యగతరేఖలు.  అయి, త్రిభుజం  వైశాల్యం 150 cm2

మరియు  అయితే, అప్పుడు AM మరియు QR ల పొడవుల మొత్తం:

Ans A.  36 cm

B. 38 cm 

C. 28 cm 

D.  24 cm
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Q.64 28a విచక్షణిగా a2 x2 + a3/2x + 3 = 0 అనేది ఒక వర్గసమీకరణం అయ్యేలా, a యొక్క సాధ్య విలువలన్నింటి
లబ్ధా న్ని కనుగొనండి.

Ans A. -12

B. 0

C. -28

D. 14

Q.65  సమీకరణం యొక్క మూలాలు  మరియు  అయితే,  విలువను కనుగొనండి:

Ans A. 12

B. 13

C. 5

D. 6

Section : Basic Science and Engineering

Q.66 అయస్కాంత అభివాహం(మాగ్నెటిక్ ఫ్లక్స్) దీనిపై ఆధారపడి ఉంటుంది:

Ans A. B యొక్క వైశాల్యం, పరిమాణం మరియు దాని అభివిన్యాసం(ఓరియెంటేషన్)

B. వైశాల్యంపై మాత్రమే

C. కోణం మాత్రమే

D. అయస్కాంత క్షేత్రం మాత్రమే

Q.67 ఒక విద్యుత్ క్షేత్రంలో ఉంచిన 2C ఆవేశం 10N బలానికి లోనైతే, ఆ పాయింట్‌లో విద్యుత్ క్షేత్రం యొక్క పరిమాణం

ఎంత?

Ans
A. 

B. 

C. 

D. 

Q.68 రెసిస్టెన్స్(నిరోధకత) స్థిరంగా ఉండగా రెసిస్టర్(నిరోధం) అంతటా పొటెన్షియల్ భేదం రెట్టింపు అయితే,
వినియోగించబడిన పవర్__________ అవుతుంది.

Ans A. రెట్టింపు

B. సగం

C. నాలుగింట ఒక వంతు

D. నాలుగు రెట్లు

Q.69 అనేక నిరోధకాలు(రెసిస్టర్లు )ని శ్రేణిలో అనుసంధానించినప్పుడు, ప్రతి నిరోధకం అంతటా ఏ భౌతిక రాశి ఒకే
విలువను కలిగి ఉంటుంది?

Ans A. విద్యుత్ప్రవాహం

B. పవర్

C. నిరోధకత(రెసిస్టెన్స్)

D. వోల్టేజ్

Q.70 ఇన్పుట్ సిగ్నల్ 4Vp-p కి అనుసంధానించబడిన R-L-C సిరీస్ సర్క్యూట్ కోసం, 1KHZ పీరియాడిక్ సైనూసోయిడల్

ac సిగ్నల్ మరియు CRO సహాయంతో రెసిస్టర్ R అంతటా కొలువబడిన వోల్టేజ్ డ్రా ప్ 2 యూనిట్ల  మొత్తం ఎత్తు
మరియు 1V వద్ద  volts /div నాబ్‌ని ఆక్రమించిన సైన్ తరంగాన్ని ప్రదర్శిస్తుం ది, R = 10Ω అయితే సర్క్యూట్ కొరకు
RMS కరెంట్ సుమారుగా ___________{ అవుతుంది.

Ans A. 1.414 A

B. 0.14 A

C. 0.071 A

D. 0.71 A
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Q.71 రెండు ట్రా న్సిస్టర్ బయాసింగ్ సర్క్యూట్‌లు S₁ = 101 మరియు S₂ = 15 స్థిరత్వ కారకాలు(స్టెబిలిటీ ఫ్యాక్టర్స్)ను కలిగి
ఉంటాయి. ఏ సర్క్యూట్ మెరుగైన ఉష్ణ  స్థిరత్వం(థర్మల్ స్టెబిలిటీ)ని అందిస్తుం ది?

Ans A. పోల్చలేము

B. రెండూ సమాన స్థిరత్వాన్ని కలిగి ఉంటాయి

C. సర్క్యూట్ 2

D. సర్క్యూట్ 1

Q.72 సమాంతర కనెక్షన్‌లో, ఒక నిరోధకం(రెసిస్టర్) విచ్ఛిన్నమైతే (ఓపెన్ సర్క్యూట్) అప్పుడు, _________.

Ans A. వోల్టేజ్ సున్నా అవుతుంది

B. బ్యాటరీ డ్యామేజ్ అవుతుంది

C. ఇతర బ్రాం చ్‌లు పనిచేస్తూ నే ఉంటాయి

D. మొత్తం సర్క్యూట్ పనిచేయడం ఆగిపోతుంది

Q.73 ఒక స్థిర వోల్టేజ్ జనకం(సోర్స్)కి 10 Ω రెసిస్టర్(నిరోధకం) అనుసంధానించబడి ఉంటుంది. మరొక రెసిస్టర్(నిరోధకం)ని
దానితో శ్రేణిలో అనుసంధానించినప్పుడు, సర్క్యూట్లో ని కరెంట్ దాని ప్రా రంభ విలువలో సగం ఉంటుంది. సప్లయి
వోల్టేజ్ మారదు అని అనుకుంటే, రెండవ రెసిస్టర్(నిరోధకం) యొక్క రెసిస్టెన్స్(నిరోధకత) __________ అవుతుంది.

Ans A. 15 Ω

B. 20 Ω

C. 5 Ω

D. 10 Ω

Q.74 ఒక ఆదర్శవంతమైన హాఫ్-వేవ్ రెక్టిఫైయర్, ఒక సైనుసోయిడల్ సోర్స్ నుండి ప్యూర్ రెసిస్టివ్ లోడ్‌ని సరఫరా
చేస్తోం ది. ఒకవేళ vL(t) అనేది లోడ్ వోల్టేజ్ మరియు vD(t) అనేది ఆనోడ్ పరంగా కొలవబడిన డయోడ్ వోల్టేజ్
అయితే, ఒక పూర్తి సైకిల్‌లో క్రింది వాటిలో ఏది ఎల్లప్పుడూ సత్యం?

Ans A. vD(t) యొక్క rms విలువ, సోర్స్ వోల్టేజ్ యొక్క rms విలువకు సమానం

B. డయోడ్ యొక్క దిశను మారిస్తే, vD(t) యొక్క సగటు విలువ సున్నా అవుతుంది

C. డయోడ్ హాఫ్ సైకిల్‌కి కండక్ట్ చేస్తుం ది కాబట్టి , vD(t) యొక్క సగటు విలువ సున్నా.

D. vL(t)మరియు vD(t) ల సగటు విలువలు పరిమాణంలో సమానంగా మరియు సంకేతాలలో వ్యతిరేకంగా ఉంటాయి

Q.75 6 Ω మరియు 3 Ω అను రెండు రెసిస్టర్లు (నిరోధకాలు) సమాంతరంగా అనుసంధానించబడి ఉన్నచో, మొత్తం

రెసిస్టెన్స్(నిరోధకత):

Ans A. 2Ω

B. 9Ω

C. 1Ω

D. 4Ω

Q.76 The SI unit of specific resistance (resistivity) is _______.

Ans A. ohm per metre

B. ohm-metre

C. ohm

D. ohm per square metre

Q.77 8051 మైక్రో కంట్రో లర్‌లోని పోర్ట్ 0, నిర్మాణపరంగా మిగిలిన పోర్ట్‌ల కంటే ప్రధానంగా ఏ విషయంలో భిన్నంగా
ఉంటుంది?

Ans A. ఇది బిట్-అడ్రసబుల్ కాదు

B. ఇది కేవలం మెమరీ ఎక్స్‌పాన్షన్ కోసం మాత్రమే కేటాయించబడింది.

C. ఇది అవుట్‌పుట్ పోర్ట్‌గా పనిచేయలేదు

D. ఇది ఇంటర్నల్ పుల్-అప్ రెసిస్టర్లను కలిగి ఉండదు

Q.78 అయస్కాంత క్షేత్రంలో విద్యుత్ప్రవాహాన్ని కలిగివున్న వాహకం(కరెంట్-క్యారీయింగ్ కండక్టర్)పై బలం _________
సందర్భంలో గరిష్టంగా ఉంటుంది.

Ans A. కరెంట్ అయస్కాంత క్షేత్రా నికి సమాంతరంగా ఉన్నప్పుడు

B. కరెంట్ అయస్కాంత క్షేత్రా నికి వ్యతిరేక దిశలో ఉన్నప్పుడు

C. కరెంట్ అయస్కాంత క్షేత్రా నికి లంబంగా ఉన్నప్పుడు

D. అయస్కాంత క్షేత్రం సున్నా ఉన్నప్పుడు B
la

c
kb

o
o

k
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Q.79 క్రింది వాటిలో, విశ్వంలోని అన్ని ప్రదేశాలలో ఒకే విధంగా ఉండే రాశి ఏది?

Ans A. గురుత్వాకర్షణ బలం

B. బరువు

C. ద్రవ్యరాశి

D. దృశ్యమాన బరువు

Q.80 r వ్యాసార్థం గల వృత్తా కార లూప్‌ ఒక ఏకరీతి అయస్కాంత క్షేత్రం లో ఉంచబడుతుంది. ఒకవేళ లూప్ యొక్క

తలం క్షేత్రా నికి లంబంగా ఉంటే, లూప్ ద్వారా అయస్కాంత అభివాహం_______ అవుతుంది.

Ans A. 2πr2B

B. 2πrB

C. πr2B

D. Br

Q.81 ఓమ్(Ohm’s) నియమం ________________ సందర్భంలో సత్యం కాకపోవచ్చు(చెల్లు బాటు కాకపోవచ్చు).

Ans A. వాహకం లోహంతో తయారు చేయబడినపుడు

B. మెటీరీయల్ రేఖీయ V-I సంబంధానికి కట్టు బడి ఉన్నపుడు

C. వాహకం యొక్క ఉష్ణో గ్రత పెరిగినపుడు

D. వాహకం యొక్క ఉష్ణో గ్రత స్థిరంగా ఉన్నపుడు

Q.82 ఇతర పరామితులను స్థిరంగా ఉంచి, హోల్స్ యొక్క చలనశీలత(మొబిలిటీ)ను దాని అసలు విలువలో సగానికి
తగ్గిస్తే, అప్పుడు p-రకం అర్థవాహకం(సెమీకండక్టర్) యొక్క వాహకత్వం(కండక్టివిటీ) _________ ఉంటుంది.

Ans A. సగానికి తగ్గు తుంది

B. మూడు రెట్లు  పెరుగుతుంది

C. రెట్టింపు అవుతుంది

D. స్థిరంగా ఉంటుంది

Q.83 క్రింది వాటిలో SI వ్యవస్థలో ప్రా ధమిక(బేస్/మూల) రాశి ఏది?

Ans A. పీడనం

B. బలం

C. పని

D. ద్రవ్యరాశి

Q.84 ఒకే మెటీరీయల్ యొక్క రెండు వాహకాలు L మరియు 2L పొడవులను కలిగి ఉంటాయి మరియు సమాన

నిరోధకత(రెసిస్టెన్స్)ను కలిగి ఉంటాయి. వాటి అడ్డు కోత(మధ్యచ్ఛేద) వైశాల్యాల నిష్పత్తి  (A1: A2) _______________.

Ans A. 1 : 2

B. 4 : 1

C. 1 : 4

D. 2 : 1

Q.85 విద్యుదయస్కాంత ప్రేరణ ద్వారా ఏ పరికరం యాంత్రిక శక్తిని విద్యుత్ శక్తిగా మారుస్తుం ది?

Ans A. బ్యాటరీ

B. ఎలక్ట్రిక్ జనరేటర్

C. ఎలక్ట్రిక్ మోటారు

D. కెపాసిటర్

Q.86 క్రింది వాటిలో ఏది ఒక పాయింట్ వద్ద  విద్యుత్ క్షేత్రా న్ని సరిగ్గా  నిర్వచిస్తుం ది?

Ans A. ప్రతి యూనిట్ ఆవేశంకి పనిచేసే బలం

B. ప్రతి యూనిట్ ఆవేశంకి అందుబాటులో ఉన్న శక్తి

C. ప్రతి యూనిట్ వైశాల్యంకి శక్తి

D. ప్రతి యూనిట్ ద్రవ్యరాశికి పనిచేసే బలం
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Q.87 1 m పొడవు మరియు 5 A విద్యుత్ప్రవాహం ఉన్న ఒక ఋజు వాహకాన్ని 0.2 T అయస్కాంత క్షేత్రా నికి లంబంగా
ఉంచినచో, ఆ వాహకంపై పనిచేసే బలం ______.

Ans A. 1.0 N

B. 0.04 N

C. 0.2 N

D. 5.0 N

Q.88 CRO యొక్క time/div నాబ్ 2 ms/div పై ఉన్నప్పుడు, పీరియాడిక్ ట్రయాంగ్యులర్ సిగ్నల్ యొక్క పాజిటివ్ హాఫ్
సైకిల్ X-అక్షం యొక్క 2 యూనిట్లను ఆక్రమిస్తే, అప్పుడు ఆ సిగ్నల్ యొక్క ఆవర్తన కాలం(టైమ్ పీరియడ్) _________
.

Ans A. 4 ms

B. 2 ms

C. 16 ms

D. 8 ms

Q.89 8051 మైక్రో కంట్రో లర్‌లో, PSEN అనేది ఒక________ అవుట్‌పుట్ సిగ్నల్, దీనిని _______ మెమరీని యాక్సెస్

చేయడానికి రీడ్ స్ట్రో బ్‌గా ఉపయోగిస్తా రు.

Ans A. యాక్టివ్ లో, ఇంటర్నల్ రామ్

B. యాక్టివ్ లో, ఎక్స్టర్నల్ ప్రో గ్రా మ్

C. యాక్టివ్ హై, ఇంటర్నల్ రామ్

D. యాక్టివ్ హై, ఎక్స్టర్నల్ ప్రో గ్రా మ్

Q.90 ఒక లాజిక్ ఫంక్షన్ F = ABC + DE గా ఇవ్వబడింది. మీరు కేవలం రెండు ఇన్‌పుట్ AND గేట్‌లు మరియు NOT
గేట్‌లను మాత్రమే ఉపయోగించగలరు. ఈ ఫంక్షన్‌ను ఇంప్లిమెంట్ చెయ్యడానికి కనీసం ఎన్ని రెండు ఇన్‌పుట్ AND
గేట్‌లు మరియు కనీసం ఎన్ని NOT గేట్‌లు అవసరం?

Ans A. 3 AND గేట్‌లు మరియు 3 NOT గేట్‌లు

B. 3 AND గేట్‌లు మరియు 2 NOT గేట్‌లు

C. 4 AND గేట్‌లు మరియు 3 NOT గేట్‌లు

D. 2 AND గేట్‌లు మరియు 1 NOT గేట్

Q.91 క్రింది ప్రకటనలలో బరువును ఏది సరిగ్గా  వివరిస్తుం ది?

Ans A. బరువుకు దిశ ఉండదు

B. బరువుకు పరిమాణం మరియు దిశ రెండూ ఉంటాయి

C. బరువు అనేది ఏదైనా ఎంత భారీగా ఉందో మాత్రమే చూపిస్తుం ది

D. బరువును కిలోగ్రా ములలో కొలుస్తా రు

Q.92 2-ఇన్‌పుట్‌ NAND గేట్ యొక్క రెండు ఇన్‌పుట్‌లను కలిపి ఒకే ఇన్‌పుట్ Aగా చేసినప్పుడు, ఫలిత సర్క్యూట్ ఏ
లాజిక్ గేట్‌లా పనిచేస్తుం ది?

Ans A. OR గేట్

B. NOT గేట్ (ఇన్వర్టర్)

C. XOR గేట్

D. AND గేట్

Q.93 ఒక PNP ట్రా న్సిస్టర్‌లో, ఎమిటర్ కరెంట్ స్థిరంగా ఉన్నప్పటికీ, కలెక్టర్-బేస్ రివర్స్ బయాస్ పెంచినప్పుడు కలెక్టర్
కరెంట్ స్వల్పంగా పెరుగుతుంది. ఇది ప్రధానంగా జరుగుతుంది ఎందుకంటే :

Ans A. కలెక్టర్-బేస్ వోల్టేజ్ పెరగడం వల్ల ఎఫెక్టివ్ బేస్ వెడల్పు తగ్గడం.

B. ఎమిటర్ ఇంజెక్షన్ సామర్థ్యం తగ్గడం.

C. డిప్లీషన్ రీజియన్ వ్యాకోచం వల్ల కలెక్టర్ నిరోధం తగ్గడం.

D. కలెక్టర్ ప్రాం తంలో హోల్ మొబిలిటీ పెరగడం.
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Q.94 3 C ఆవేశాన్ని 3 సెకన్లలో 15 V పొటెన్షియల్ భేదం అంతటా తరలించినట్లయితే, ఈ ప్రక్రియలో అభివృద్ధి  చెందిన
పవర్ ఎంత?

Ans A. 10 W

B. 15 W

C. 5 W

D. 30 W

Q.95 5 kgల బరువున్న ఒక వస్తు వు భూమిపై సుమారు 49 N గురుత్వాకర్షణ బలాన్ని అనుభవిస్తుం ది. ఉపయోగించిన g
విలువ సుమారుగా:

Ans A. 19.6 m/s²

B. 4.9 m/s²

C. 2 m/s²

D. 9.8 m/s²

Q.96 సర్క్యూట్ రేఖాచిత్రంలో రెసిస్టర్‌(నిరోధకం)ని సూచించడానికి ఏ సంకేతం ఉపయోగించబడుతుంది?

Ans A. జిగ్-జాగ్ లైన్

B. రెండు సమాంతర ప్లేట్లు

C. యారో మార్క్

D. పాయింటర్‌తో కూడిన వృత్తం

Q.97 ఒక కూలంబ్ ఆవేశం సుమారుగా __________ యొక్క ఆవేశానికి సమానం.

Ans A. 6 × 1012ఎలక్ట్రా న్లు

B. 6 × 1018ఎలక్ట్రా న్లు

C. 6 × 1010ఎలక్ట్రా న్లు

D. 6 × 106ఎలక్ట్రా న్లు

Q.98 ఉష్ణో గ్రత పెరుగుదలతో ఒక అర్ధవాహకం యొక్క నిరోధకత్వం(రెసిస్టివిటి) తగ్గు తుంది, ఎందుకనగా:

Ans A. లాటిస్ కంపనాలు ఆగిపోతాయి

B. ఎలక్ట్రా న్లు  శక్తిని కోల్పోతాయి

C. మరిన్ని ఛార్జ్ క్యారియర్లు  ఉత్పత్తి చేయబడతాయి

D. బ్యాండ్ గ్యాప్ పెరుగుతుంది

Q.99 క్రింది మెటీరీయల్‌లలో ఏది విద్యుత్ సర్క్యూట్‌లలో ఉత్తమ ఇన్సులేటర్‌గా పనిచేస్తుం ది?

Ans A. ప్లా స్టిక్

B. మెర్క్యురీ

C. గ్రా ఫైట్

D. ఇనుప రాడ్

Q.100 ఒక ఏకరీతి అయస్కాంత క్షేత్రం ఒక సర్ఫేస్(ఉపరితలం) యొక్క సమతలానికి సమాంతరంగా ఉంటే, ఆ ఉపరితలం
గుండా అయస్కాంత అభివాహం _______ అవుతుంది.

Ans A. గరిష్టంలో సగం

B. సున్నా

C. గరిష్టం

D. అనంతం
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